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Objective 

The purpose of this lab is to teach students how to design a printed circuit board (PCB) based on 

a circuit schematic. They will use Eagle to recreate the circuit and design a PCB with the 

corresponding components. Making custom libraries and parts as well as proper identification 

and layout will be introduced. 

 

Background 

A Printed Circuit Board is a board that has pads that are connected with traces (lines) which 

make a circuit. It allows electrical components to be connected and get power when they are 

soldered to this board. Solder is metal that glues the component to the board and it provides the 

connection between them. A PCB is made up of many layers of different materials, as shown in 

Figure 1.  

 

 
Figure 1. PCB composition 

The substrate (FR4) is fiberglass which gives the board rigidity and insulates each side from the 

other. The copper is the conductive material in the board. It can be only on one side of the board 

or more commonly on both sides to have a double sided board. The next layer, the soldermask, is 

placed on top of the copper to avoid unwanted contact from other conductive elements. The 

white silkscreen is then placed on top to indicate the position of different components or any 

notations you would like to add. 

 

Figure 1 shows a 2-layer board, but more inner layers can be created by sandwiching multiple 2-

layer substrates. If connections need to be made between layers, then holes need to be drilled 

then plated through inside with metal to make the connection between the layers (Figure 2). 

These holes are called vias. We are making a 2-layer through hole board, which means our 

components will have pins that pass through the PCB and will be soldered on the opposite side. 

 
Figure 2. PCB internal routes 

 



Through hole vias are the most common and the cheapest, since it is easiest to drill a hole all the 

way through a piece of material with layers that have already been sandwiched together. 

 

Designing and using a PCB should be the last step after testing your circuit first on a breadboard, 

then on a prototyping board. These methods are used in the prototyping stages of your design 

while a PCB is more of a final product but is not always. 

 

Eagle will be used since it’s free, can be used on many platforms and has lots of support out 

there. It is also one of the industry standards. We will be going over the basics but feel free to 

look at Eagle (http://eagle.autodesk.com/eagle/documentation) as well as sparfkfun tutorials 

(https://learn.sparkfun.com/tutorials) for some more complicated functionality and more 

explanations. 

 

 

Apparatus and Equipment Overview 

The following components will be used in this lab: 

• 1 x computer 
• 1 x mouse (optional) 
• 1 x internet (to download Eagle) 

 

Pre-Lab Preparation 

 

Before arriving in the lab, students should review the lab manual and familiarize themselves with 

the lab setup and procedures. Students are encouraged to use their own computers for this lab, 

provided that they have downloaded and installed Eagle 

(https://www.autodesk.com/products/eagle/free-download). 

 

 

Prelab Questions 

 

What does PCB stand for? 

              

              

 

What keeps a PCB rigid? 

              

              

 

What is the conductive material used in a PCB? 

              

              

 

Explain how you would make a connection that started on one side of a board and then continued 

on another. 

              

              

http://eagle.autodesk.com/eagle/documentation
https://learn.sparkfun.com/tutorials
https://www.autodesk.com/products/eagle/free-download


 

Why is it important to have a silkscreen on a PCB? 

              

              

 

 

Overview 

 

The following circuit diagram and parts list should be referenced throughout the lab, it is a 

circuit for a USB charger. Each team member should try to do this lab. 

 
Figure 3. Circuit diagram 

Table 1. Parts list 

PART VALUE DESCRIPTION Didgikey part num 

U1 7805 Voltage Regulator LM7805CT-ND 

LED Standard Output Light-Emitting Diode C5SMF-BJE-CR0U0451-ND 

R1 330 Ω Resistor CF14JT330RCT-ND 

R2 75 kΩ Resistor CF14JT75K0CT-ND 

R3 75 kΩ Resistor CF14JT75K0CT-ND 

R4 51 kΩ Resistor CF14JT51K0CT-ND 

R5 51 kΩ Resistor CF14JT51K0CT-ND 

D1 1N4004 Rectifier Diode 1N4001-TPMSCT-ND 



USB Type A Socket Solderable 36-921-ND 

9V 9V Battery Connector 36-232-ND 

SW - ON/OFF switch 563-1565-ND 

 

 

 

 

Terminology 

• Schematic/diagram: visual representation of a circuit with symbols 

• Symbol: representation of a component visually 

• Package: representation of a component based on its physical configuration 

• Device: part with linked symbol and package 

• Library: add new parts in a custom folder (library) to keep track of them 

• Eagle Schematic/Board: you can switch between the schematic (symbol) and board 

(package) in Eagle  

 

Eagle Tools 

• Group : select one or many components 

• Move : click on the little + on each component to move them 

• Rotate : click on a component to rotate 90o 

• Add : add new component 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

Procedure 

 

Part A – Making the schematic  

 
Figure 4. Circuit schematic in Eagle 

 

1. Open Eagle and create a new project, File>New>Project, name it USB charger or 

something similar. 

 

 
 



2. Right-click on your new project to start making your schematic, New>Schematic. 

 
3. To make the circuit you will need all the components. Click on the ‘add a part’ button to 

open the existing ones in the available libraries. You can search ‘resistor’ for example or 

a part number like ‘LM7805’. 

 
4. When making the schematic, for our purposes, the symbol in the schematic doesn’t 

matter. However when it comes to the board the size of the part needs to correspond with 

the actual one that we have so it can be soldered to the PCB. To do that, you can google 

the digikey part number to find the package (it’s the size, orientation, etc of the physical 



part). Ex: package of the voltage regulator is TO-220 which can be found in the Eagle 

library. 

 

 
5. Refer to the parts list to get all of the proper parts on your workspace, search in Eagle for 

the part number, part name or package to find the right one. If you were to go through 

this process on your own you would have to find all the packages in the datasheets of all 

components but here is a list to help you for this lab: 

a. Voltage regulator- LM7805, use package TO220V (vertical orientation to 

minimize space) 

b. LED- led5mm 

c. Resistors- resistor, pick from the R-US list anything bigger then 207/7 (they have 

a power rating of 0.25W which is package 207 and they are 6mm long) 

d. Diode- 1N4004 (DO41 package) 



e. USB socket- PN87520 

f. Battery connector- AB9V 

g. Switch- you will notice that you can’t find a proper part, you will make your own 

 
 

 

Part B – Making a custom component 

 

1. First open the datasheet of the part you are creating (the switch MFS201N-9-Z). 

2. You will create your own library. In the control panel, click File>New>Library. In the 

new window that pops up click save and name it (make sure to save it in lbr which is 

libraries). 

        
 

3. Start with the symbol of the part, click ‘Add Symbol…’ in your library and name it 

MFS201N-9-Z. 

 

 



4. Create a box with ‘Line’ and add the correct amount of pins to it (6 in our case). You can 

rotate things with the rotate button . The size of this symbol doesn’t really matter. 

                     

5. Name the pins so they correspond with the datasheet with the name button . Make 

sure the part is centered by selecting all of it with the group button  and moving it to 

the middle cross. If you don’t see the middle cross, you may want to zoom out a little 

until it becomes more clear 

 
 

          
 

6. Click the text button  to add name and value tags, then move them to Names and 

Values layers respectively with >Layer… by clicking on the tags. 



 

7. Save your symbol and start making the package (footprint) with the package button . 

Name it MFS201N-9-Z. 

8. The size of the package is very important since our physical part will need to fit in the 

board. Since our diagram is in metric we need to change the grid  to mm. 

 

9. Place the right amount of pads  on your workspace. Right-click on them to get to 

Properties. Change their name, position (x, y) and drill size to correspond with the 

datasheet. You can change the shape if you want. 

       

X                  Y 



 
 

10. Two drill holes also need to be added for this switch , change their properties as well. 

To add a different size of drill, click >Drill>… 

11. You should also indicate where the outlines of the part will be. Use line  to draw a 

box around the pads and holes. Make sure the layer is tDocu before drawing the line. 

Adjust the coordinates of the corners with properties of the lines. 

 
 

          
 

12. Add >NAME and >VALUE with the text button , placing them on the tNames and 

tValues layers respectively (in properties). 

13. You are now ready to associate the symbol with the package. Save your package and 

open the device , name it MFS201N-9-Z. 

Pad X Y 

1 1.25 4 

2 1.25 0 

3 1.25 -4 

4 -1.25 4 

5 -1.25 0 

6 -1.25 -4 

Drill top 0 8.25 

Drill bottom 0 -8.25 

(3.75, 8.5) (-3.75, 8.5) 

(3.75, -8.5) (-3.75, -8.5) 



14. Add your symbol with the add button  and place it in the middle of the workspace. 

Click ‘New’ in the bottom right to add your package. 

 
15. Associate the pins in the symbol with the pads in the package with ‘Connect’. Click 

‘Connect’ again in the new window to link them and then save it. 

 
16. Finally, add this part to your schematic by navigating to the part in the control panel 

(Librairies>Name_of_your_library>MFS201N-9-Z) and click ‘Add’. *Your schematic 

needs to be open. Complete your circuit with the net wire button . 

 
 

 

 



Part C – Making the board 

 

1. Click on switch to board  to see all the packages of the parts. Use the rotate  and 

move tool  to arrange them inside the white box while trying to visualise where the 

traces will be. Try and compact all the parts to make a small PCB (cheaper).  

 

2. When your parts are placed, use the route tool  to permanently place the copper traces 

on the board. We could use both layers but it is possible to only use one, choose the top 

layer for the traces (red). Make sure that they don’t come too close to any other 

components or cross any other traces. 

a. Note: try to route your connections without moving your components to untangle 

all the wires. 

b. Remember that a trace can pass between two holes from a component (passing 

over the lines from the silkscreen layer).  

c. Remember that Eagle will show you a certain arrangement of connections but you 

can change them following the rules of electrical nodes and circuitry. Ex. If all 

negative pins of components are connected to the negative battery terminal, then 

any one of the pins can be connected to each other and only one needs to touch 

the battery. 

3. When everything else is done, use the Design Rule Check (DRC)  to make sure your 

board is ready to be printed. 

4. Save your file in a safe location. 

5. Get rid of all your connections with the ripup tool  and try again using the autoroute 

button  only for the top layer. Save this new file using a different name so that you 

can compare the two, what differences do you notice? 

______________________________________________________________________________

______________________________________________________________________________ 

 

 

Next steps 

 

Next week you will be given a PCB with this circuit, made by us, and all of the components to 

allow you to practice through-hole soldering. Compare our design with yours and let us know if 

and how yours is better☺  

 

 

 

 



Additional Resources 

• Here is a similar tutorial for Eagle that you might find useful, 

https://learn.sparkfun.com/tutorials/using-eagle-schematic  

• To practice your PCB design skills and for project ideas you can look for some here: 

https://circuitdigest.com/diy-pcb-projects.  

https://learn.sparkfun.com/tutorials/using-eagle-schematic
https://circuitdigest.com/diy-pcb-projects

